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Requirements 

You should have Rational Application Developer for WebSphere Software v7.5 

with J2EE Connector (J2C) Tools installed if you want to follow the steps.  

The article assumes the reader has some basic knowledge of ant scripts. We will 

not explain the basics of how the ant script works. J2C ant scripts are already 

supported in Rational Application Developer for WebSphere Software v7, we will 

only explore the specifics for the CICS Container Link support in the generated 

ant script.  

If you are interested in the basics of J2C ant script, this paper Working with J2C 

Ant Scripts in Rational Application Developer v7 will give you some basic 

knowledge.  

http://ltsbwass001.sby.ibm.com/cms/developerworks/rational/library/06/1205_ho-benedek/
http://ltsbwass001.sby.ibm.com/cms/developerworks/rational/library/06/1205_ho-benedek/
http://ltsbwass001.sby.ibm.com/cms/developerworks/rational/library/06/1205_ho-benedek/
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Introduction 
Level: Intermediate 

 

In IBM Rational Application Developer for WebSphere Software version 7.5, one 

of the key features in J2C Connector Tools is the CICS Channel Support. You can 

generate J2C Java Beans and Data binding files from importing Cobol source that 

contains CICS Channel commands. You can save the settings into an Ant script 
when you go through the J2C Bean wizard or the CICS/IMS Data Binding wizard. 

 

This article is divided into two major sections.  

1. The first section is for readers who are interested in using the tooling for 

CICS Container Link Support in Rational Application Developer v7.5.  

 

2. The second section is for users who like to explore the generated ant 

scripts. The sample ant scripts included in this article were created using 
these J2C Tools.  
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CICS Channel Introduction 

CICS Channel 

In the past, CICS application programs use communication area COMMAREA to 

exchange data. The new CICS Channel support enhances how data is transferred 
between programs.  

Containers are named blocks of data designed for passing information between 

programs. You can think of them as named communication areas (COMMAREAs). 

Programs can pass any number of containers between each other. Containers are 

grouped together in sets called channels; a channel is analogous to a parameter 
list.  

Here are some of the benefits of Channel/Container model over COMMAREA:  

 Unlike COMMAREA, channels are not limited in size to 32KB. There is no 

limit to the number of containers that can be added to a channel, and the 

size of individual containers is limited only by the amount of storage that 

you have available.  

 Because a channel can comprise multiple containers, it can be used to 

pass data in a more structured way. In contrast, a COMMAREA is a 

monolithic block of data.  

 Unlike COMMAREAs, channels don't require the programs that use them to 

know the exact size of the data returned.  
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CICS Sample Cobol Program EC03 

This sample server program listing1 below demonstrates the use of channels and 

containers in a CICS program. It queries the length of data in a container and 

places the length, the current date and the current time into containers 

InputDataLength, CurrentDate and CurrentTime respectively. A message 

indicating success or failure is returned in container OutputMessage. If no channel 
is passed to the program it abends with abend code NOCH. 

EC03 is a Basic CICS Server Cobol sample program which is used with the 

frontend sample programs to demonstrate the use of External Call Interface (ECI) 
with channels and containers.  

The following code is sample code created by IBM Corporation. This sample code 

is not part of any standard IBM product and is provided to you solely for the 

purpose of assisting you in the development of your applications. The code is 

provided 'as is', without warranty or condition of any kind. IBM shall not be liable 

for any damages arising out of your use of the sample code, even if IBM has been 
advised of the possibility of such damages.  

 

Listing 1.Samples CICS program with Channels 

 
       IDENTIFICATION DIVISION. 

       PROGRAM-ID. EC03. 

        

       ENVIRONMENT DIVISION. 

       CONFIGURATION SECTION. 

       DATA DIVISION. 

       WORKING-STORAGE SECTION. 

 

      *  Container names 

       01 DATECONTAINER      PIC X(16) VALUE 'CurrentDate'. 

       01 TIMECONTAINER      PIC X(16) VALUE 'CurrentTime'. 

       01 INPUTCONTAINER     PIC X(16) VALUE 'InputData'. 

       01 OUTPUTCONTAINER    PIC X(16) VALUE 'OutputMessage'. 

       01 LENGTHCONTAINER    PIC X(16) VALUE 'InputDataLength'. 

 

      *  Data fields used by the program 

       01 INPUTLENGTH        PIC S9(8) COMP-5. 

       01 CURRENTTIME        PIC S9(15) COMP-3. 

       01 CHANNELNAME        PIC X(16) VALUE SPACES. 

       01 OUTPUTSTRING       PIC X(72) VALUE SPACES. 

       01 DATESTRING         PIC X(16) VALUE SPACES. 

       01 TIMESTRING         PIC X(16) VALUE SPACES. 

       01 RESPCODE           PIC S9(8) COMP-5. 

       01 RESPCODE2          PIC S9(8) COMP-5. 

 

       PROCEDURE DIVISION. 

       MAIN-PROCESSING SECTION. 

 

      *  Get name of channel 

           EXEC CICS ASSIGN CHANNEL(CHANNELNAME) 

                            END-EXEC. 
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      *  If no channel passed in, terminate with abend code NOCH 

           IF CHANNELNAME = SPACES THEN 

                EXEC CICS ABEND ABCODE('NOCH') NODUMP 

                            END-EXEC 

           END-IF. 

 

      *  Read content length of container InputData 

           EXEC CICS GET CONTAINER(INPUTCONTAINER) 

                            CHANNEL(CHANNELNAME) 

                            NODATA FLENGTH(INPUTLENGTH) 

                            INTOCCSID(037) 

                            RESP(RESPCODE) 

                            RESP2(RESPCODE2) 

                            END-EXEC. 

 

      *  Check response code 

           EVALUATE RESPCODE 

 

      *  Container not passed in 

             WHEN DFHRESP(CONTAINERERR) 

               STRING INPUTCONTAINER 

                            DELIMITED BY SPACE 

                      ' container was not passed to the program' 

                            DELIMITED BY SIZE 

                            INTO OUTPUTSTRING END-STRING 

 

      *  Container is BIT not CHAR 

             WHEN DFHRESP(CCSIDERR) 

               IF RESPCODE2 = 3 

                 STRING 'Container ' 

                            DELIMITED BY SIZE 

                        INPUTCONTAINER 

                            DELIMITED BY SPACE 

                        ' type is BIT, not CHAR' 

                            DELIMITED BY SIZE 

                            INTO OUTPUTSTRING END-STRING 

               END-IF 

 

      *  Read from container OK 

             WHEN DFHRESP(NORMAL) 

               STRING 'Read from ' 

                            DELIMITED BY SIZE 

                      INPUTCONTAINER 

                            DELIMITED BY SPACE 

                      ' container successfully' 

                            DELIMITED BY SIZE 

                            INTO OUTPUTSTRING END-STRING 

 

               EXEC CICS PUT CONTAINER(LENGTHCONTAINER) 

                            FROM(INPUTLENGTH) 

                            FLENGTH(LENGTH OF INPUTLENGTH) 

                            BIT NOHANDLE END-EXEC 

 

      *  Other response code 

             WHEN OTHER 

               STRING 'The GET CONTAINER command returned an', 
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                      ' unexpected response code' 

                            DELIMITED BY SIZE 

                            INTO OUTPUTSTRING END-STRING 

 

           END-EVALUATE. 

 

      *  Place output string in container OutputData 

           EXEC CICS PUT CONTAINER(OUTPUTCONTAINER) 

                            FROM(OUTPUTSTRING) 

                            FLENGTH(LENGTH OF OUTPUTSTRING) 

                            CHAR FROMCCSID(037) 

                            END-EXEC. 

 

      *  Get the current time and date 

           EXEC CICS ASKTIME ABSTIME(CURRENTTIME) 

                            END-EXEC. 

 

      *  Format date and time 

           EXEC CICS FORMATTIME ABSTIME(CURRENTTIME) 

                            DDMMYYYY(DATESTRING) DATESEP('/') 

                            TIME(TIMESTRING) TIMESEP(':') 

                            END-EXEC. 

 

      *  Place current date in container CurrentDate 

           EXEC CICS PUT CONTAINER(DATECONTAINER) 

                            FROM(DATESTRING) 

                            FLENGTH(LENGTH OF DATESTRING) 

                            CHAR FROMCCSID(037) 

                            END-EXEC. 

 

      *  Place current time in container CurrentTime 

           EXEC CICS PUT CONTAINER(TIMECONTAINER) 

                            FROM(TIMESTRING) 

                            FLENGTH(LENGTH OF TIMESTRING) 

                            CHAR FROMCCSID(037) 

                            END-EXEC. 

 

      *  Finish 

           EXEC CICS RETURN END-EXEC. 

 

           EXIT. 
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J2C tools for CICS Channel Support 

The J2C Tools in Rational Application Developer for WebSphere Software v7.5 

provide CICS Channel Support in different ways.  

Wizards Support  

You can create the J2C generated artifacts for CICS Channel Support using J2C 

wizards. The two wizards also support ant script generation. It enables you to go 

through the wizard once, choose the CICS Channel to Java Mapping and record 
the user options and data in an Ant script file.  

The two wizards are:  

1. CICS IMS Data Binding wizard: It will generate one or more data binding 

files.  

2. J2C Java Bean wizard: It will generate J2C beans, import resource 
adapters as well as data binding files.  

 

Samples Support  

There are prebuilt samples where you can import into your workspace and 

explore the generated code. You can execute the generated code if you install the 

Cobol CICS channel copy book to your CICS system.  

The sample is located in Help > Samples > Technology samples > Java > 

J2C Samples > CICS Adapter samples > Container link support  

Figure 0. CICS container Sample  
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Deployment Support  

The deployment support is not specific to the CICS Container Link. It is a generic 

support for all generated J2C Java beans since Rational Application Developer for 

WebSphere Software v7. There is a deployment wizard in J2C Tools for you to 

deploy the generated J2C Java bean into faces JSP, simple JSP, Web Service and 

EJBs. You can just use simple JSP to unit test your generated code without 
writing any client code.  

There are two flows for deployment:  

 You can go through the deployment as part of the flow when you create 

J2C Java beans. 

 You can create J2C Java beans and invoke the deployment wizard 

separately. 

 The J2C ant script generated during wizard flow does not include 
deployment information.  It only records options for code generation. 



     

 

 Page 11 of 75 “Rational Support Whitepaper”  
   

 

Data Binding generation in CICS/IMS Data Binding 
wizard 

The CICS IMS Data Binding wizard allows you to generate data binding files based 

on the Cobol, C or PL/1 source. When you go through the wizard, you have to 

select different options in the wizard before you can generate the data binding 

files. The Ant script support will save all the settings in the data binding Ant script 
file.  

Figure 1 shows you how to launch the CICS IMS Data Binding wizard.  

1. Select File > New > Other. 
2. Select J2C > CICS IMS data Binding. 

Figure 1. CICS IMS Data Binding wizard 
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1. Click Next in the CICS IMS Data Binding wizard to launch the Data Import 

page. 

2. Choose COBOL CICS Channel to Java, C Language CICS Channel to 

Java or PL1 CICS Channel to Java mapping.  

Figure 2. Choose COBOL CICS Channel to Java Mapping 

 

3. Select the Cobol, PL1, or C source file. 

There is a sample CICS Channel Cobol source ec03.cpp located in the 

Rational Application Developer for WebSphere Software install shared 

folder under the plug-in com.ibm.j2c.cheatsheet.content.v7.0.1.xxxx.  
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Figure 3. Import Cobol source 

 

4. Click Next to launch the Importer page. 

5. Select the importer settings and the data structure to be imported. 

For the sample ec03.cpp, select 

DATECONTAINER,INPUTCONTAINER,TIMECONTAINER,OUTPUTCONTAINER 
and LENGTHCONTAINER from the data structures section.  
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Figure 4. Select data structure from Cobol source 

 

6. Click Next to launch the Saving Properties Page shown in Figure 5.  

Click on the CICS Channel, enter the Project name, Package Name, Class 

Name and Channel Name. Enter EC03ChannelRecord as CICS channel 
java class name and InputRecord as channel Name.  

You will select the Save session as Ant script checkbox to use the Ant 

script feature. The default Data Binding Ant Script file name is the name of 

the Channel Data binding class name. The default location of Ant script will 

be the current Project where the Channel Data Binding is generated. You 
can change the name and location for the Ant script generation.  

The Save All Settings option is useful if you would like to generate the 

values for all the settings when you go through the wizard. In this way, it 

is like you have generated a template for all the properties. If you do not 

select the Save All Settings option, only the option that you modify or 
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enter when you go through the CICS IMS Data Binding wizard will be 

generated. For example, the default value for Generation Style is 

Default. The Generation Style will be generated in the Ant script only if 

you select another style like Shorten names.  

Figure 5.Enter CICS Channel properties in Saving Properties Page 

 

For each of the data structures (Container) under the CICS channel, enter 

the corresponding Package Name, Class Name, Channel Name and 

Container names. Select the Container Type for each of the Container as 
indicated below.  
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Data Structure Container Name Container Class 

Name 
Container 

Type 

DATECONTAINER CURRENTDATE DateContainer CHAR 

TIMECONTAINER CURRENTTIME TimeContainer CHAR 

OUTPUTCONTAINER OUTPUTMESSAGE OutputContainer CHAR 

INPUTCONTAINER INPUTDATA InputContainer CHAR 

LENGTHCONTAINER INPUTDATALENGTH LengthContainer BIT 

Figure 6.Enter DateContainer properties in Saving Properties 
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Enter TimeContainer as Java class Name  
 

Figure 7.Enter TimeContainer properties Saving Properties 
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Enter InputContainer as Container Java class Name  

Figure 8.Enter InputContainer Saving Properties 
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Enter OutputContainer as Container Java class Name  

Figure 9.Enter OutputContainer properties Saving Properties 
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Enter LengthContainer as Container Java class Name  

Figure 10.Enter LengthContainer properties Saving Properties 

 

7. Click the Finish button to generate the Data Binding files as well as the 

ant script.  
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Generated Code 

 For each of the container, there is one Java data binding generated.  

 The generated CICS Channel class EC03ChannelRecord.java acts as a 

wrapper class for all the containers. It has getter and setter for each of the 

container class.  
 The CICS Channel class will be used as input and output data type.  
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J2C Java bean generation that supports CICS 
Channel commands 

The J2C Java Bean wizard creates a bean that communicates with an Enterprise 

Information System. Figure 4 shows where the J2C Java Bean wizard is under the 

J2C folder.  

To find the J2C Java Bean wizard shown in Figure 11:  

1. Select File > New > Other. 
2. Select J2C > J2C Java Bean wizard. 

 

Figure 11. J2C Java Bean Wizard  
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Figure 12 shows the Save session as Ant Script support in the J2C Java Bean 
Output Properties page. To go to this page:  

1. Select J2C Java Bean wizard and click Next.  

2. In the Resource Adapter Selection page, select the resource adapter 

ECIResourceAdapter v7.1.0.2 and click Next. The 

ECIResourceAdapter v7.1.0.2 provides CICS Channel Support.  

3. The Connection Properties page launches. Enter the connection 

information and click Next.  
4. You will now go to the J2C Java Bean Output Properties page.  

 

Figure 12. J2C Java Bean Output Properties page  

 

In the J2C Java Bean Output Properties page, specify the name of your J2C Java 

Bean Interface and Implementation file, as well as the project name and package 

name of where they will be generated. 
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Select the Save session as Ant script checkbox to use the Ant script feature.  

The default J2C Java Bean Ant Script file name is the name of the J2C Java Bean 

interface. The default location of the Ant script will be the current Project where 

the J2C bean is generated. You can change the name and location for the Ant 

script generation. The Save All Settings option is useful if you would like to 

generate the values for all the settings when you go through the wizard. This is a 

good way to capture for informational purposes all of the values that were used, 

and it makes it easier for you to change a particular value in the future. If you do 

not select the Save All Settings option, only the option that you modify or enter 
when you go through the J2C Java Bean wizard will be generated.  

After you select the Save session as Ant script option, click Next to go to the 
Java Methods Page.  

 
Figure 13. J2C Java Method page  
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Click the Add button in the Java Methods page to create the Java Method.  

In the Java Method Page show in figure 14, enter invoke as the method Name.  

 

Figure 14. J2C Java Method page  

 

Click the Browse button to select the data type to be used for the Input Data 

Type.  

We will select EC03ChannelRecord which is created in the CICS/IMS Data 
Binding as shown in previous section.  
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Figure 15. J2C Java Method page  

 

Note that when the CICS Channel type is used as Input Data type, the Output 

data type is required to be the same.  

Click the Finish button to continue.  
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Figure 16. J2C Java Methods page  

 

In the InteractionSpec properties for invoke method, enter EC03 as the 

FunctionName as shown in Figure 17. This functionName has to match your CICS 

Cobol server Program id. For the sample EC03.cpp, the Program id is EC03.  

Click the Finish button to continue generating the J2C Java Bean interface and 
Implementation code.  
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Figure 17. J2C Java Methods page Function Name 
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Generated Code 

 There will be a J2C Java Bean Interface and Implementation class 

generated.  

 The method in the class will have CICS Channel class 
EC03ChannelRecord.java as the input and output data type.  

 

Figure 18. Generated Code 

 

Doclets 

J2C doclet tags enable you to specify particular characteristics of your J2C Java 

bean. The J2C Java bean consists of an interface and an implementation class 

(Impl.java). The implementation section of the Java bean contains J2C doclets 
that you can edit using the tags listed in the following pages.  
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You can modify the doclets property value e.g. the jndi-name or value of the 

functionName, the method body will be regenerated automatically. It is not 

recommended to add any user code to the method body; it will be overwritten 

once the regeneration of the method body occurs.  

 

Listing 15. Doclets in the generated code 

  
/** 

 * @j2c.connectionFactory jndi-name="MyCICS32KJNDIName" 

 * @j2c.connectionSpec 

class="com.ibm.connector2.cics.ECIConnectionSpec" 

 * @generated 

 */ 

public class EC03Impl implements sample.cics.data.EC03 { 

 

 private ConnectionSpec typeLevelConnectionSpec; 

 private InteractionSpec invokedInteractionSpec; 

 private InteractionSpec interactionSpec; 

 private ConnectionSpec connectionSpec; 

 private Connection connection; 

 private ConnectionFactory connectionFactory; 

 

/** 

* @j2c.interactionSpec 

class="com.ibm.connector2.cics.ECIInteractionSpec" 

* @j2c.interactionSpec-property name="functionName" value="EC03" 

* @generated 

*/ 

public sample.cics.data.EC03ChannelRecord invoke( 

 sample.cics.data.EC03ChannelRecord arg) 

 

Note that in listing16, there are special tags to the Java source code for the CICS 

Container Link support. Some of them are:  

 @type-descriptor.CICSChannel  
 @type-descriptor.CICSContainer  

Listing 16. Doclets in the generated Channel code 

  
/** 

 * @generated 

 * Generated Class: EC03ChannelRecord 

 * @type-descriptor.CICSChannel channel-name="EC03ChannelRecord" 

 * @type-descriptor.CICSContainer class-

name="sample.cics.data.OutputContainer"  

 *   container-name="OUTPUTDATA" container-type="CHAR" 

 * @type-descriptor.CICSContainer class-

name="sample.cics.data.DateContainer"  

 *   container-name="CURRENTDATE" container-type="CHAR" 

 * @type-descriptor.CICSContainer class-

name="sample.cics.data.TimeContainer"  

 *   container-name="CURRENTTIME" container-type="BIT" 

 * @type-descriptor.CICSContainer class-
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name="sample.cics.data.InputContainer"  

 *   container-name="INPUTMESSAGE" container-type="CHAR" 

 * @type-descriptor.CICSContainer class-

name="sample.cics.data.LengthContainer"  

 *   container-name="INPUTDATALENGTH" container-type="BIT" 

 */ 
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Deploying J2C Java Bean 

Deploying J2C Java Bean using the standalone deployment wizard 

After you have generated the J2C Java Bean Interface and Implementation, you 

can use the Web Page, Web Service, or EJB from J2C Java Bean to deploy as 
Simple JSP.  

1. Select J2C > Web Page, Web Service, or EJB from J2C Java Bean.  

Figure 19. Standalone deployment wizard 
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2. Select the Browse button to locate the J2C Java Bean  

Figure 20. Browse for J2C Java Bean 

 

 

 

 

 

 

 

 

 

 

 

 



     

 

 Page 34 of 75 “Rational Support Whitepaper”  
   

 

3. Enter ? in the Find J2C Bean wizard.  

A list of files will be displayed for your selection. Select EC03Impl from the 
list.  

Figure 21. Browse for J2C Java Bean 
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4. Click Next in the J2C Java Bean Selection page.  

Figure 22. J2C Java Bean selection 
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5. In the Deployment Page, select Simple JSP. Press Next 

Figure 23.Deployment wizard 
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6. Enter Web Project Name and select New button.  

Figure 24. Deploying 
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7. Press Finish button in the New Dynamic Web Project wizard to create the 
web project.  

Press Finish again in the Deployment page to generate the JSP.  

Figure 25. Create Web Project 
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Deploying J2C Java Bean as part of the J2C Java Bean creation 

You will be able to deploy as part of the J2C Java Bean creation. In figure 17 J2C 

Java Method Page Function Name, instead of press Finish to generate the J2C 

Java Bean, just select the Next button.  

Then it will get you to the deployment wizard page in figure 22. Just follow the 
same steps (step 4 to step 7) in the above section to deploy as Simple JSP.  

Congratulations, you have learned how to generate a CICS Container Link J2C 

application using the J2C Tools. If you want to learn about the J2C Ant script 

support, you can continue to the next section.  
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J2C Ant scripts support 

Ant session recording for CICS Channel support 

In section 1, we show you how to use the wizard to generated J2C Java Beans 

and also record a wizard session. The ant session recording enables you to go 

through the wizard once, choose the CICS Channel to Java Mapping and record 

the user options and data in an Ant script file. The two wizards where the Ant 
script generation is supported are:  

 CICS IMS Data Binding wizard: The Ant script will generate one or more 

data binding files.  

 J2C Java Bean wizard: The Ant script will generate J2C beans, import 

resource adapters as well as data binding files.  
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Layout of Data Binding Ant scripts 

Layout of Data Binding Ant scripts. See Listing 2 below;  

The generated data binding script is composed of targets, tasks, types and 

properties. To find out more about how Ant works, go to 

http://Ant.apache.org/manual/.  

The script has one custom task, discover. The rest of the tags are custom types. 

Data discovery occurs in two distinct steps, which can be easily identified in the 

sample script with the performImport and writeToWorkspace complex elements 
(Ant custom types).  

Both custom types contain the necessary data required for language (COBOL, 

PL1, or C) file import and (data binding bean) artifact generation.  

The import and generation is performed internally, using a Discovery Agent and a 

Workspace Resource Writer respectively. Depending on the language file being 

imported and the generated artifact type, various implementations can be used. 

Each implementation is identified by its ID (javax.xml.namespace.QName). 

Language files such as COBOL, C, and PL/1 are some examples for which an 

agent implementation exists. In this example, the imported type is a COBOL file 

with CICS Channel support. Processing this type of COBOL file uses the same 

Discovery Agent as for the MPO case, hence the ID of 

{com/ibm/adapter}MPOCobolDiscoveryAgent is used. The same logic applies for 

writers as well. The writer ID for COBOL CICS Channel to Java is 
"{com/ibm/adapter/cobol/cicschannel/writer}JAVA_WRITER" 

The file import (COBOL) data and the data necessary to write the artifact (Java) 

is stored using custom property types like propertyElement and propertyGroup. 
This is the format the agents and writer can handle.  

Note that at the end of the script, we have done a refreshLocal and 

incrementalBuild. This is to allow the Annotation builder to regenerate the code in 

method body based on all the doclet Tags in the J2C bean and data binding file, 

and to synchronize the project.  

 

http://ant.apache.org/manual/
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Listing 2.Samples Data Binding Ant scripts with CICS Channel Support 

 
<?xml version="1.0" encoding="UTF-8"? > 

<project default="DataBinding1"  

            name="/CICS32KSample/EC03ChannelRecord.xml"  

            xmlns:adapter="http://com.ibm.adapter" > 

  <property name="debug" value="true"/ > 

  <property name="project1" value="CICS32KSample"/ > 

  <target name="DataBinding1" > 

    <adapter:createProject projectName="${project1}"  

                           projectType="Java"  

                           sourceFolder="src"/ > 

    <adapter:discover > 

      <adapter:performImport 

agent="{com/ibm/adapter}MPOCobolDiscoveryAgent" > 

        <adapter:importResource > 

          <adapter:propertyGroup name="CobolFileGroup" > 

            <adapter:propertyElement name="CobolFile"  

                                     

value="D:\IBM\SDP70Shared\plugins\ 

                                     

com.ibm.j2c.cheatsheet.content_7.0.1. 

                                     v20080710-

1450\Samples\CICS32K\ec03.ccp"/ > 

          </adapter:propertyGroup > 

        </adapter:importResource > 

        <adapter:queryProperties > 

          <adapter:propertyGroup name="ImportProperties" > 

            <adapter:propertyElement name="Platform" value="Win32"/ > 

            <adapter:propertyElement name="Codepage" value="ISO-8859-

1"/ > 

            <adapter:propertyElement name="Numproc" value="PFD"/ > 

            <adapter:propertyElement name="FloatingPointFormat" 

value="IEEE 754"/ > 

              <adapter:propertyGroup name="ExternalDecimalSignGroup" 

> 

                <adapter:propertyElement name="ExternalDecimalSign" 

value="ASCII"/ > 

              </adapter:propertyGroup > 

            <adapter:propertyGroup name="EndianGroup" > 

              <adapter:propertyElement name="Endian" value="Little"/ 

> 

              <adapter:propertyElement name="RemoteEndian" 

value="Little"/ > 

            </adapter:propertyGroup > 

            <adapter:propertyGroup name="CompileOptions" > 

              <adapter:propertyElement name="Quote" value="DOUBLE"/ > 

              <adapter:propertyElement name="Trunc" value="STD"/ > 

              <adapter:propertyElement name="Nsymbol" value="DBCS"/ > 

            </adapter:propertyGroup > 

          </adapter:propertyGroup > 

        </adapter:queryProperties > 

        <adapter:queryResult > 

          <adapter:selectElement name="DATECONTAINER"/ > 

          <adapter:selectElement name="TIMECONTAINER"/ > 
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          <adapter:selectElement name="INPUTCONTAINER"/ > 

          <adapter:selectElement name="OUTPUTCONTAINER"/ > 

          <adapter:selectElement name="LENGTHCONTAINER"/ > 

        </adapter:queryResult > 

      </adapter:performImport > 

      <adapter:writeToWorkspace  

                  

writer="{com/ibm/adapter/cobol/cicschannel/writer}JAVA_WRITER" > 

        <adapter:propertyGroup name="MPO_PG"> 

          <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

          <adapter:propertyTree name="MPO_TP" > 

            <adapter:propertyNode name="COBOLMPOToJavaResourceWriter" 

> 

              <adapter:propertyGroup name="Java Type Name" > 

                <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

                <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

                <adapter:propertyElement name="Class Name" 

value="EC03ChannelRecord"/ > 

                <adapter:propertyElement name="Overwrite existing 

class" value="true"/ > 

                <adapter:propertyElement name="CHANNEL_NAME" 

value="InputRecord"/ > 

              </adapter:propertyGroup > 

            </adapter:propertyNode > 

            <adapter:propertyNode name="COBOLImportResult0" > 

              <adapter:propertyGroup name="COBOLToJavaResourceWriter" 

> 

                <adapter:propertyGroup name="Java Type Name" > 

                  <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

                  <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

                  <adapter:propertyElement name="Class Name" 

value="DateContainer"/ > 

                  <adapter:propertyElement name="Overwrite existing 

class" value="true"/ > 

                  <adapter:propertyElement name="GenerationStyle" 

value="Default"/ > 

                  <adapter:propertyElement name="CONTAINER_NAME" 

value="CURRENTDATE"/ > 

                  <adapter:propertyElement name="CONTAINER_TYPE" 

value="BIT"/ > 

                </adapter:propertyGroup > 

              </adapter:propertyGroup > 

            </adapter:propertyNode > 

            <adapter:propertyNode name="COBOLImportResult1" > 

              <adapter:propertyGroup name="COBOLToJavaResourceWriter" 

> 

                <adapter:propertyGroup name="Java Type Name" > 

                  <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

                  <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

                  <adapter:propertyElement name="Class Name" 
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value="TimeContainer"/ > 

                  <adapter:propertyElement name="Overwrite existing 

class" value="true"/ > 

                  <adapter:propertyElement name="GenerationStyle" 

value="Default"/ > 

                  <adapter:propertyElement name="CONTAINER_NAME" 

value="CURRENTTIME"/ > 

                  <adapter:propertyElement name="CONTAINER_TYPE" 

value="BIT"/ > 

                </adapter:propertyGroup > 

              </adapter:propertyGroup > 

            </adapter:propertyNode > 

            <adapter:propertyNode name="COBOLImportResult2" > 

              <adapter:propertyGroup name="COBOLToJavaResourceWriter" 

> 

                <adapter:propertyGroup name="Java Type Name" > 

                  <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

                  <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

                  <adapter:propertyElement name="Class Name" 

value="InputContainer"/ > 

                  <adapter:propertyElement name="Overwrite existing 

class" value="true"/ > 

                  <adapter:propertyElement name="GenerationStyle" 

value="Default"/ > 

                  <adapter:propertyElement name="CONTAINER_NAME" 

value="INPUTDATA"/ > 

                  <adapter:propertyElement name="CONTAINER_TYPE" 

value="BIT"/ > 

                </adapter:propertyGroup > 

              </adapter:propertyGroup > 

            </adapter:propertyNode > 

            <adapter:propertyNode name="COBOLImportResult3" > 

              <adapter:propertyGroup name="COBOLToJavaResourceWriter" 

> 

                <adapter:propertyGroup name="Java Type Name" > 

                  <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

                  <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

                  <adapter:propertyElement name="Class Name" 

value="OutputCiontainer"/ > 

                  <adapter:propertyElement name="Overwrite existing 

class" value="true"/ > 

                  <adapter:propertyElement name="GenerationStyle" 

value="Default"/ > 

                  <adapter:propertyElement name="CONTAINER_NAME" 

value="OUTPUTMESSAGE"/ > 

                  <adapter:propertyElement name="CONTAINER_TYPE" 

value="BIT"/ > 

                </adapter:propertyGroup > 

              </adapter:propertyGroup > 

            </adapter:propertyNode > 

            <adapter:propertyNode name="COBOLImportResult4" > 

              <adapter:propertyGroup name="COBOLToJavaResourceWriter" 

> 
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                <adapter:propertyGroup name="Java Type Name" > 

                  <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

                  <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

                  <adapter:propertyElement name="Class Name" 

value="LengthContainer"/ > 

                  <adapter:propertyElement name="Overwrite existing 

class" value="true"/ > 

                  <adapter:propertyElement name="GenerationStyle" 

value="Default"/ > 

                  <adapter:propertyElement name="CONTAINER_NAME" 

value="INPUTDATALENGTH"/> 

                  <adapter:propertyElement name="CONTAINER_TYPE" 

value="BIT"/ > 

                </adapter:propertyGroup > 

              </adapter:propertyGroup > 

            </adapter:propertyNode > 

          </adapter:propertyTree > 

        </adapter:propertyGroup > 

      </adapter:writeToWorkspace > 

    </adapter:discover > 

    <eclipse.refreshLocal depth="infinite" resource="${project1}"/ > 

    <eclipse.incrementalBuild project="${project1}"/ > 

  </target > 

</project > 
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Layout of J2C Java Bean Ant scripts 

The following sample (shown in Listing 3) describes the J2C bean generation 

portion of the Ant file generated as a result of J2C Java Bean session recording.  

The script is organized into different targets that depend on each other. The 

different targets will be executed sequentially according to the dependency.  

The script has one task, generateService. The two distinct sections are 

buildService and writeToWorkspace. The first section is different from the 

previous example, since the service is being built, not discovered. It assumes that 

the EC03ChannelRecord.java file and all container Classes exist under the 

CICS32KSample project and the sample.cics.data package.  

The second section is identical to the writeToWorkspace from CICS/IMS Data 
Binding, with the difference in the values being used.  

Among the described tasks, the Ant file contains two additional helper tasks. The 

createProject task, as its name implies, it is used for project creation. The 

importResourceAdapter task is used for importing resource adapter and creating 

a connector project cicseci7102  

Layout of J2C Java Bean Ant scripts. See Listing 3 below; 

 

Listing 3. Sample Code for J2C Java Bean Ant script 

 
<?xml version="1.0" encoding="UTF-8"? > 

<project default="J2CBeanGeneration1"  

            name="/CICS32KSample/EC03.xml"  

            xmlns:adapter="http://com.ibm.adapter"  

            xmlns:j2c="http://com.ibm.adapter.j2c" > 

  <target name="Init1" > 

    <property name="debug" value="true"/ > 

    <property name="project1" value="CICS32KSample"/ > 

    <property name="ra.project" value="cicseci7102"/ > 

    <property name="ra.runtime" value="WebSphere Application Server 

v7.0 stub"/ > 

    <property name="ra.file"  

              

value="D:\IBM\SDP751\ResourceAdapters\cics15\cicseci7102.rar"/ > 

  </target > 

  <target depends="Init1" name="DataBinding1" > 

    <adapter:createProject projectName="${project1}"  

                           projectType="Java"  

                           sourceFolder="src"/ > 

    <eclipse.refreshLocal depth="infinite" resource="${project1}"/ > 

    <eclipse.incrementalBuild project="${project1}"/ > 

  </target > 

  <target depends="DataBinding1" name="importResourceAdapter1" > 

    <j2c:importResourceAdapter addToEAR="no"  

                               connectorFile="${ra.file}"  

                               connectorModule="${ra.project}"  
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                               targetRuntime="${ra.runtime}"/ > 

  </target > 

  <target depends="importResourceAdapter1" name="J2CBeanGeneration1" 

> 

    <adapter:createProject projectName="${project1}"  

                           projectType="Java"  

                           sourceFolder="src"/ > 

    <j2c:generateService > 

      <j2c:buildService class="EC03" package="sample.cics" > 

        <j2c:method > 

          <j2c:methodName value="invoke"/ > 

          <j2c:methodInput  

                  

value="/CICS32KSample/src/sample/cics/data/EC03ChannelRecord.java"/ > 

          <j2c:methodOutput  

                  

value="/CICS32KSample/src/sample/cics/data/EC03ChannelRecord.java"/ > 

          <j2c:interactionSpec 

class="com.ibm.connector2.cics.ECIInteractionSpec" > 

            <adapter:propertyGroup 

name="INTERACTION_SPEC_PROPERTY_PG" > 

              <adapter:propertyElement name="functionName" 

value="EC03"/ > 

              <adapter:propertyElement name="commareaLength" value="-

1"/ > 

              <adapter:propertyElement name="replyLength" value="-1"/ 

> 

              <adapter:propertyElement name="executeTimeout" 

value="0"/ > 

              <adapter:propertyElement name="interactionVerb" 

value="1"/ > 

            </adapter:propertyGroup > 

          </j2c:interactionSpec > 

        </j2c:method > 

        <j2c:managedConnectionFactory  

                  

class="com.ibm.connector2.cics.ECIManagedConnectionFactory"  

                  target="MyDefaultJNDIName" > 

          <adapter:propertyGroup 

name="MANAGED_CONNECTION_FACTORY_CLASS_PROPERTIES" > 

            <adapter:propertyGroup name="Server" > 

              <adapter:propertyElement name="ConnectionURL" 

value="myURL"/ > 

              <adapter:propertyElement name="ServerName" 

value="myServer"/ > 

            </adapter:propertyGroup > 

            <adapter:propertyGroup name="UserVerification" > 

              <adapter:propertyElement name="UserName" 

value="myName"/ > 

              <adapter:propertyElement name="Password" 

value="myPassword"/ > 

            </adapter:propertyGroup > 

            <adapter:propertyElement name="TraceLevel" value="2"/ > 

            <adapter:propertyGroup name="Security"/ > 

          </adapter:propertyGroup > 

        </j2c:managedConnectionFactory > 

        <j2c:connectionSpec 
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class="com.ibm.connector2.cics.ECIConnectionSpec"/ > 

        <j2c:resourceAdapter project="${ra.project}"/ > 

      </j2c:buildService > 

      <adapter:writeToWorkspace  

        

writer="{com/ibm/adapter/j2c/codegen/writer}J2CAnnotationWorkspaceRes

ourceWriter"> 

        <adapter:propertyGroup name="J2C Java Bean Writer Properties" 

> 

          <adapter:propertyElement name="Project" 

value="CICS32KSample"/ > 

          <adapter:propertyElement name="PackageName" 

value="sample.cics"/ > 

          <adapter:propertyElement name="InterfaceName" value="EC03"/ 

> 

        </adapter:propertyGroup > 

      </adapter:writeToWorkspace > 

    </j2c:generateService > 

    <eclipse.refreshLocal depth="infinite" resource="${project1}"/ > 

    <eclipse.incrementalBuild project="${project1}"/ > 

  </target > 

</project > 
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Customization 

In order to customize the J2C Ant scripts, you need to know the following:  

 What property to change 

 What property value to set 

 Where can you find the lists of valid property values 

Some of the properties can be easily identified from the J2C UI, and you can view 
the list of possible values in a drop-down list.  

Create Project Type 

 Basic Information 

There are three project types that you can set:  

o Java  

o Web  
o EJB  

The sourceFolder represents the source folder in the project. The Java 

project creation wizard allows users to change the source folder default 

name or create multiple source folders. The Web and EJB projects require 

the runtimeName to be specified. The runtimeName is a string that can be 

determined from the preference page in the Runtime Environments under 

the Server option.  

Note: The ${project1} value for the projectName is an Ant variable 

defined through <property name="project1" value="CICS32KSample"/>.  

 Information in Ant Script 

 

Listing 4. Create Java project in Ant script 

      

 
<adapter:createProject projectName="${project1}"  

                       projectType="Java"  

                       sourceFolder="src"/> 
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The code snippet in Listing 5 shows how to create a Web project.  

1.  In addition to the projectType, you need to specify the runtimeName. 

 

Listing 5. Sample code for create Web Project in Ant script 

      
<adapter:createProject projectName="${project1}"  

                       projectType="Web"  

                       runtimeName="WebSphere Application Server 

v7.0"> 

 

 

If add To EAR is specified when you create the Web project, you need to specify 

the EARProjectName and addToEAR option besides the runtimeName.  

Listing 6. Sample code for create Web Project with EAR in Ant script 

      
 <adapter:createProject EARProjectName="MyWebEAR"  
                        addToEAR="yes" 

                        projectName="${project1}"  

                        projectType="Web"  

                        runtimeName="WebSphere Application Server 

v7.0"/> 

The code snippet in Listing 7 shows how to create an EJB project.  

2. In addition to the projectType, you need to specify the runtimeName. 

Listing 7. Sample code for create EJB Project in Ant script 

      
<adapter:createProject projectName="${project1}"  

                       projectType="EJB"  

                       runtimeName="WebSphere Application Server 

v7.0"/> 

 

If add To EAR is specified when you create the EJB Project, you need to specify 

the EARProjectName and addToEAR option besides the runtimeName.  
 

Listing 8. Sample code for create EJB Project with addToEAR enabled in 

Ant script 

      
<adapter:createProject EARProjectName="MyEJBEAR"  

                       addToEAR="yes"  

                       projectName="${project1}"  

                       projectType="EJB"  
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                       runtimeName="WebSphere Application Server 

v7.0"/> 

 

Information in wizard 

The Project Type is located in the New Source Project Creation wizard as 
shown in figure 26.  

Figure 26.Different Project Type in wizard 

 

The Web Project Type EAR Project Name and Option "Add EAR to Project" is 
located in New Dynamic Web Project wizard as shown in figure 27.  
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Figure 27.Web Project creation 

 

The EJB Project Type EAR Project Name and Option "Add EAR to Project" is 

located in New EJB Project wizard as shown in figure 28.  
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Figure 28.EJB Project options 
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queryResult 

 Basic Information 

The queryResult represents the COBOL structures to be selected in the 

resulted query. When the COBOL file is analyzed a query is executed and 

the returned result can be a flat or nested structure of COBOL elements.  

 Information in Ant Script 

Listing 9. Sample queryResult section in J2C Java Bean Ant script 

      
  <adapter:queryResult> 
     <adapter:selectElement name="DATECONTAINER"/> 

     <adapter:selectElement name="TIMECONTAINER"/> 

     <adapter:selectElement name="INPUTCONTAINER"/> 

     <adapter:selectElement name="OUTPUTCONTAINER"/> 

     <adapter:selectElement name="LENGTHCONTAINER"/> 

  </adapter:queryResult> 

 

 

 Information in wizard 

Figure 29.queryResult and the corresponding page in wizard 
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Discovery Agent 

 Basic Information 

Some of the properties are implicit and do not show up in the J2C UI. One 
example is the Discovery Agent ID.  

You will not see any of the agent name 

"{com/ibm/adapter}MPOCobolDiscoveryAgent" in the UI. However, if you 

select the language mapping to be COBOL CICS Channel to JAVA or 

COBOL MPO to Java, then you will see the agent name generated in the 
Ant script.  

COBOL CICS Channel to Java is using the same pattern as MPO COBOL to 

Java, so they are using the same discovery agent.  

 Information in Ant Script 

Listing 4 shows the agent name when you select 

COBOL_CICS_CHANNEL_TO_JAVA or COBOL_MPO_TO_JAVA 
mapping.  

Listing 10. Sample Discovery Agent section in J2C Java Bean Ant script 

      
        <adapter:discover> 
            <adapter:performImport 

agent="{com/ibm/adapter}MPOCobolDiscoveryAgent"> 

                <adapter:importResource> 

                    <adapter:propertyGroup name="CobolFileGroup"> 

                        <adapter:propertyElement name="CobolFile" 

value= 

"D:\70Shared\plugins\com.ibm.j2c.cheatsheet.content_7.0.1\Samples\CIC

S32K\ec03.ccp"/> 

                    </adapter:propertyGroup> 

   

 

 Information in wizard 

The choose Mapping is located in the Data Import page inside the 
CICS/IMS Data binding wizard and J2C Bean wizard.  
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Figure 30. Discovery agent and the corresponding page in wizard 
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Resource Writer 

 Basic Information 

While a Discovery Agent reads the language files to generate an in 

memory model of the artifacts to be generated, the Workspace Resource 

Writer takes the model and generates the artifacts using the properties 

specified by the user. And the same as for the agent, the writer is 

transparent to the user throughout the wizard. Its ID surfaces in the Ant 
script only.  

 Information in Ant Script 

Listing 11. writer and and write properties in Data Binding Ant script  

 
<adapter:writeToWorkspace  

            

writer="{com/ibm/adapter/cobol/cicschannel/writer}JAVA_WRITER" > 

  <adapter:propertyGroup name="MPO_PG"> 

    <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

    <adapter:propertyTree name="MPO_TP" > 

      <adapter:propertyNode name="COBOLMPOToJavaResourceWriter" > 

        <adapter:propertyGroup name="Java Type Name" > 

          <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

          <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

          <adapter:propertyElement name="Class Name" 

value="EC03ChannelRecord"/ > 

          <adapter:propertyElement name="Overwrite existing class" 

value="true"/ > 

          <adapter:propertyElement name="CHANNEL_NAME" 

value="InputRecord"/ > 

        </adapter:propertyGroup > 

      </adapter:propertyNode > 

      <adapter:propertyNode name="COBOLImportResult0" > 

        <adapter:propertyGroup name="COBOLToJavaResourceWriter" > 

          <adapter:propertyGroup name="Java Type Name" > 

            <adapter:propertyElement name="Project Name" 

value="CICS32KSample"/ > 

            <adapter:propertyElement name="Package Name" 

value="sample.cics"/ > 

            <adapter:propertyElement name="Class Name" 

value="DateContainer"/ > 

            <adapter:propertyElement name="Overwrite existing class" 

value="true"/ > 

            <adapter:propertyElement name="GenerationStyle" 

value="Default"/ > 

            <adapter:propertyElement name="CONTAINER_NAME" 

value="CURRENTDATE"/ > 

            <adapter:propertyElement name="CONTAINER_TYPE" 

value="BIT"/ > 
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          </adapter:propertyGroup > 

        </adapter:propertyGroup > 

      </adapter:propertyNode > 

 

 

 

Listing 12. writer and and write properties in J2C Bean Ant script  

      
<adapter:writeToWorkspace  

   

writer="{com/ibm/adapter/j2c/codegen/writer}J2CAnnotationWorkspaceRes

ourceWriter"> 

  <adapter:propertyGroup name="J2C Java Bean Writer Properties"> 

        <adapter:propertyElement name="Project" 

value="CICS32KSample"/ > 

        <adapter:propertyElement name="PackageName" 

value="sample.cics"/> 

        <adapter:propertyElement name="InterfaceName" value="EC03"/> 

    </adapter:propertyGroup > 

</adapter:writeToWorkspace> 

 

 

 Information in wizard 

The write properties for the COBOLTOJavaResourceWriter is located in the 

Saving Properties page of the CICS/IMS Data Binding as shown in previous 

section from figure 5 through figure 10. This includes the Project, 
PackageName and InterfaceName.  

The write properties for the J2CAnnotationWorkspaceResourceWriter is 

located in J2C Java bean Output Properties page as shown below in figure 
22. This includes the Project, PackageName and InterfaceName.  
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Figure 31. J2C Java Bean Output Properties page  
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Running Ant Script 

Running Ant Script in the workspace 

Here are the steps to run the ant script inside the Rational Application Developer 

for WebSphere Software v7.5  

 Bring up a clean workspace.  

 Create a Project and copy the generated ant script into the project. In this 

example, we will copy the EC03InputChannelRecord.xml which will 

generate the Channel data binding files and the container data binding 

files.  

 Right Click on the Ant script file and select Run As > 3 Ant Build.. as 

shown in figure 32. You only need to do this once in each workspace to set 

up the JRE environment. The next time you can select Run As > 2 Ant 
Build  

Figure 32. Run As > 3 AntBuild 

 

 In the Edit Configuration and launch page, click on the JRE tab.  
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Figure 33. Setting up JRE 

 

 Select run in the same JRE as the workspace. 
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Figure 34. Same JRE as the workspace 

 

 Click on the Run button to execute the ant script  
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Figure 35. Run Ant script 

 

 In the Console, you will see the execution progress of the ant script. if you 

see "Build Success", the ant script is executed successfully  
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Figure 36. Console 

 

 In the Enterprise Explorer view, you will see the generated data binding 

files.  
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Figure 37. Generated files 
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Running Ant Script from command line 

The generated Data binding Ant scripts can be executed without launching the 

eclipse workbench. Once generated or modified, you can execute a script from 

the Microsoft Windows command line without bringing up the IDE. Running 

Rational Application Developer for WebSphere Software in this way is called 

headless mode. To run the Ant script, invoke the antRunner application passing 

the Ant file as argument. A simple batch file for running the generated Ant scripts 

in headless mode is shown in Listing 14, following:  

 

Listing 14. Batch file to invoke data binding Ant script  

  
echo on 

setlocal 

 

set ECLIPSE="D:\IBM\SDP750" 

set WORKSPACE=D:\workspace\testAntCICS32K 

set BUILDFILE=D:\workspace\EC03InputChannelRecord.xml 

 

 

set JAVA_HOME=%ECLIPSE%\jdk 

SET 

EQUINOXJAR=%ECLIPSE%\plugins\org.eclipse.equinox.launcher_1.0.100.v20

080509-1800.jar 

set PATH=%JAVA_HOME%\bin;%PATH% 

set CLASSPATH=%JAVA_HOME%\lib;%CLASSPATH% 

 

echo "Generating the databinding file.." 

java -cp %EQUINOXJAR% org.eclipse.core.launcher.Main -clean -data 

%WORKSPACE%  

-application org.eclipse.ant.core.antRunner -buildfile %BUILDFILE% 

 

 

Where:   

 ECLIPSE environment variable defines the path to the eclipse folder 

within Rational Application Developer for WebSphere Software 

 WORKSPACE defines the path where the workspace will be created 

 BUILDFILE is the path to your generated Ant script you would like to 

run. 

    

 

To run the Ant file generated from the CICS/IMS Data Binding session, modify the 

values of the following variables in the Test.bat batch file to fit your environment.  

 Replace the value for ECLIPSE with your eclipse root directory (where 

eclipse.exe is located)  

 Replace the value for WORKSPACE with the workspace name and location  

 Replace the value for BUILDFILE with your J2C Ant script  

 Make sure that the %EQUIOXJAR% is correct, check if that jar file exists. 

The name of the org.eclipse.equinox.launcher_xxx.jar may be different, 
then you need to make modifications  
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If the debug property is set to True, you should see progress messages and a 

BUILD SUCCESSFUL message at the end. You can also browse to the target 
workspace to see the generated files.  

To run the Data binding ant script from the command line, you can invoke 

Test.bat as show in figure 38.  

Figure 38. Console showing Ant script execution 

 

After the test.bat completes successfully, you can go to the workspace and all the 

projects and data binding files are created, as shown in figure 37.  
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Figure 39 Generated data binding files by Ant script 
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Tips 
 

The default WebSphere Application Server runtime is v7.0 in Rational Application 

Developer for WebSphere Software v7.5.x. 

 

For Java project, this is the default runtime always selected when you execute the 

ant script. 

  

Always ensure the following projects are consistent in their WebSphere 

Application Server runtime and JRE level to avoid undesired behavior. 

 

 Connector project 

 Project for Data binding generation 

 Project for J2C Java Beans generation (can be same project as Data binding 

generation)  

 

 

To modify the WebSphere Application Server runtime in the project, do one of the 

following to bring up the Java Build Path 

 

 Click on the project and select Properties and click Java Build Path 

or 

 Click on the project, select Build Path > Configure Built Path 
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You can select Add Library to select the right Server runtime version and JRE 

version you want. 

To change the Server Runtime. 

 

Select Server runtime in the Add Library 
 

 
 

Select the server runtime you desired, press Finish. 
 
 



     

 

 Page 71 of 75 “Rational Support Whitepaper”  
   

 

 
 
 

To change JRE version, in Add Library. 
 

 
 
 
 

Select Alternate JRE, click on Installed JREs.. button 
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Select the JRE you desire. 
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Summary 

This article has shown you how to create J2C Java Beans and Data Binding beans 

from a Cobol program that support CICS Channel and save the session 
information into an Ant scripts.  

You can run the ant script to regenerate the same artifacts without going through 
the wizard again.  

You can also customize the ant script to generate similar artifacts.  

 

Resources 
 

Learn 

 The out-of-service date of your version of the WebSphere Application 

Server. 

 Using Ant with WebSphere Studio Application Developer. 

 Troubleshooting headless Ant builds with Rational Application Developer. 

 Exploiting CICS Channels and Containers from Java clients, 

 In the Architecture area on developerWorks, get the resources you need to 

advance your skills in the architecture arena. 

 Browse the technology bookstore for books on these and other technical 

topics.  

 

Discuss 

 Check out developerWorks blogs and get involved in the developerWorks 

community.  

 

 

 

 

 

http://www.ibm.com/software/support/lifecycle/
http://www.ibm.com/software/support/lifecycle/
http://www.ibm.com/developerworks/websphere/library/techarticles/0203_searle/searle1.html/
http://www-128.ibm.com/developerworks/websphere/library/techarticles/0505_weisz/0505_weisz.html/
http://www.ibm.com/developerworks/websphere/library/techarticles/0810_wakelin/0810_wakelin.html/
http://www.ibm.com/developerworks/architecture
http://www.ibm.com/developerworks/apps/SendTo?bookstore=safari
http://www.ibm.com/developerworks/blogs/
http://www.ibm.com/developerworks/community/
http://www.ibm.com/developerworks/community/
http://www.ibm.com/developerworks/community/
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